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About this tutorial
Congratulations on your selection of XMPie uCreate Print for your Variable Data Print (VDP) needs. 

The XMPie EDU Tutorial is a series of tutorials that together will provide a thorough introduction to VDP 
techniques using Adobe InDesign and XMPie uCreate Print.

The EDU Tutorial is divided into different sections to enable you to quickly jump forward or backward to 
find help to learn different aspects of the product functionality:

	z Part 1 - Project planning, preparation and gathering
	| Understanding the project 
	| Checking the available data
	| Checking the available image and text file assets
	| Planning what content objects are needed to achieve the desired outcome

	z Part 2 - Basic VDP job
	| Linking to your data source
	| Placing Text and Graphic Content objects into the InDesign document
	| Managing text copy fitting and dynamic graphic fitting
	| Creating your first VDP output

	z Part 3 - Using rules and logic
	| Introduction to the Rule editor
	| Functions and how to use them
	| Creating rule or logic

	z Part 4 - Introducing more content object types
	| Creating and using Visibility, Style and Text File content objects

	z Part 5 - Barcodes
	| Creating and using print barcodes

	z Part 6 - uImage regular font effects
	| Creating a font-based uImage template with Adobe Photoshop
	| Creating a uImage Document Package
	| Optimization techniques

	z Part 7 - uImage image font effects
	| Creating an image-font-based uImage template with Adobe Photoshop 
	| Creating a uImage Document Package
	| Optimization techniques

	z Part 8 - Using the uImage package in uCreate Print
	| Linking InDesign and uCreate Print to the uImage package

	z Part 9 - Table Content objects and uChart
	| Linking to secondary data sources
	| Table Content objects
	| Adding uChart to the document

	z Part 10 - Working with uProduce
	| Creating Campaign- and Document-packages
	| Uploading packages to the uProduce Dashboard
	| Processing the document on the server
	| Working with Circle
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Target audience
This tutorial is designed to provide basic information, step-by-step instructions, and sample materials for 
self-learning. Should you require more visual assistance, there are accompanying videos available at  
http://campus.xmpie.com/s/uCreatePrint. 

At the end of this Tutorial, there are review questions, and suggested exercises to build on the skills 
outlined in the tutorial.

The content is designed for customers who have bought XMPie uDirect or PersonalEffect and wish to 
learn how to use XMPie's uCreate Print product to create document templates for VDP production.

It is expected that the reader will already have a basic working knowledge of Adobe InDesign. If not, it is 
recommended to first complete some basic InDesign training  for example, courses with Adobe: 
https://helpx.adobe.com/indesign/tutorials.html or a 3rd party organization such as Lynda.com: 
https://www.lynda.com/InDesign-training-tutorials/233-0.html

Document structure
This tutorial uses the following icons to draw your attention to special key items to help you identify the 
information you are looking for when completing the tutorial.

Sections of the tutorial which require hands on action will be highlighted with the following icon.

Step by step instructions

This is an example of step by step instructions.

Reference materials
	z uCreate Print User Guide (Access via the online help link in the Dynamic Content menu).
	z uCreate Print Tutorial videos (Access at http://campus.xmpie.com/s/uCreatePrint)

Prerequisites
This tutorial assumes that you:

	z Are familiar with InDesign CC, 
	z have a basic understanding of Excel or text-based data, and
	z have a basic understanding of the aims of Variable Data Print (VDP).
	z have Adobe InDesign CC2023 installed (trial version is acceptable) 

Additional information and notes

This is an example of additional information and notes.

NOTE: Special attention and warning

This is an example of special attention and warning.

http://campus.xmpie.com/s/uCreatePrint
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Module 1: 
Introduction and overview
In this module, we download and unzip the tutorial resource files. We will investigate the provided files, 
and get ready to start work in InDesign.  This overview will also describe what we want to achieve in this 
sample tutorial.

Duration
About 10 minutes

Objectives
After completing this module, you will be able to:

	z Unzip and open a sample InDesign file provided by a colleague or customer, and
	z Describe the rules or conditions that are needed to change the text and in the document for this 

tutorial.

Procedure
Previous tutorials and sample files

This tutorial is part of a series. It is recommended that you have downloaded and completed the previous 
tutorials. If you have, you can continue to use the files you have already started creating. Alternatively you 
can download the files ready to start this tutorial.

Unzip and review the contents

Step by step instructions

Unzip the resources package. You should see the following files:
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Open the InDesign document

Step by step instructions

Launch InDesign and open the EDU Postcard Template CC2023.indd file.

If you have problems opening the file with your version of InDesign, then open the EDU_
Static.idml file and Save as... to save it as an INDD document. If you use the IDML file, you will 
need to repeat the steps outlined in Tutorials 2 and 3 before starting this tutorial.

Re-link to the data source (if necessary)

Step by step instructions

If you receive this warning dialog, then 
click Relink and browse to the EDU201x 
Prospective Students.csv file provided in the 
tutorial zip file.

Re-link images (if necessary)

Step by step instructions

If InDesign prompts you about modified links, 
click to Update Links

InDesign should locate the images automatically. If not, follow these optional steps:

Open the Links panel: Window -> 
Links (Ctrl-Shift-D). 

Select the links that have the caution icon, and select to Relink... the links from the panel 
menu. 

Locate the image of the same name in the resources or assets folder. InDesign should offer 
to relink other images found in the same folder. If not, repeat the process until all images are 
relinked.
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Install or replace missing document fonts (if necessary)

The tutorial document uses the fonts Impact and Myriad Pro, which should be automatically installed 
by Adobe InDesign. If either or both fonts are not available on your computer, InDesign will prompt you  
about missing fonts. You can look for them online and install them, or simply replace the fonts with one 
you already have installed. 

Step by step instructions

If InDesign prompts you about 
missing fonts, then click Find 
Fonts... and select to replace 
the missing fonts with one 
already installed on your 
computer.

Set High Quality display performance

Step by step instructions

From the InDesign 
View menu, 
select Display 
Performance and 
then High Quality 
Display.

Alternatively, use 
the Ctrl+Alt+H 
keyboard shortcut.
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Review campaign requirements

Before starting any VDP job, it is recommended to look at the document and the data to understand what 
information you have, and what needs to change in the document. It can also be very helpful to write a 
list of ADORs or content objects that are needed to complete the job.

In this tutorial, we are going to continue the EDU Postcard document we started in the previous tutorial.

The invitation postcard document looks like this:

Additional information and notes

ADOR (Automatic Dynamic Object Replacement) is a patented XMPie technology for objects 
that can be dynamically changed or replaced in the document. For example a Text ADOR can 
change text in the document. We also refer to ADORs as Content Objects.
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The data for this tutorial looks like this:

And the following text files are available in the assets folder:

With the document design requirements, data, and assets, we can now define the content objects and 
rules we need to create. Below is the list of tasks for this tutorial. For your reference, each is followed by 

the tutorial page number.

Front page tasks
	z Hide the Scholarship information if Grade Average is less than 85 - page 12. 
	z Change the background color to be the School color - page 16.
	z If necessary, change the font color so it is readable over the new school color - page 20.
	z Change the Agenda table for each School - page 22.

Back page tasks
	z Change the background color to be the School color - page 19.
	z If necessary, change the font color so it is readable over the new school color - page 20.
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Module 2: 
Visibility Content objects
Visibility Content objects allow you to show/hide Pages or Layers in the InDesign document. For this 
example, the university only wants to show the scholarship information to students with a grade average 
above 85, and the designer has put the scholarship information onto a separate InDesign layer.

Duration
About 10 minutes.

Objectives
After completing this module, you will be able to:

	z Create a Visibility Content object,
	z Define a rule that returns true/false to show/hide a layer,
	z Set the Visibility Content object onto an InDesign layer.

Procedure
Checking the layer that will become dynamic

Step by step instructions

Open the Layers panel from the Window menu or hit F7.

This document has been setup with the Grey box, asterisk graphic and scholarship text box 
on the Scholarship layer. You can manually turn off/on the Scholarship layer by clicking the 
eye  icon on the Scholarship layer. We want to do this automatically based  on a rule.

On the second page, you will also find the a text box highlighted green to show that it is on 
the Scholarship layer.
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Creating a new Visibility Content object

Step by step instructions

In the Dynamic Content panel, right-click and 
select New Content Object... 

If the panel is not visible, open it from the 
Window menu, XMPie group. 

Set a Name for the new content object.

Set the Type to Visibility.

Check the bnox to Edit Rule.

Set the rule shown on the 
left: 

Is visible if GradeAvg > 
Number 85.

Click OK.

Your new Visibility Content object will appear in 
the panel list.

Additional information and notes

In this sample file, the objects have already been moved to a unique layer. In 
your future projects you will have to create a new layer and move the objects to 
the layer that you will hide.



14	 XMPie EDU Tutorial Part 4 - More Content object Types	 XMPie Training

Setting the Visibility content object onto the layer

Step by step instructions

In the Layers panel, select the 
Scholarship layer.

In the Dynamic Content panel, 
double-click the Scholarship 
Visibility content object.

Confirm that you are 
assigning the Visibility object 
onto the correct layer.

Click Assign.

Scroll through the records to confirm that the 
layer shows and hides correctly. 

Record 1 has a Grade Average of 89 so the layer should show. 

Record 2 has a Grade Average of 83 so the layer should hide.

Additional information and notes

The Visibility Content object is affecting the layer on all pages of the document.
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Additional information and notes

Note that you can also set the Visibility object onto layers by selecting one or 
more layers in the Layers panel, and using the Layers panel menu to select the 
Layer Visibility option from the Dynamic Content group. 

Then, select the Visibility object from the 
drop-down list and click OK.

You can also remove the Visibility object from layers by selecting None from the 
drop-down and clicking OK.

Additional information and notes

In addition to layers, Visibility objects can also be assigned to pages/spreads in 
the same way, but using the Pages panel (F12) instead of the Layers panel.
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Module 3: 
Style Content objects
Style content objects allow you to control InDesign Character or Object styles dynamically. For this 
example, the university wants to show the school color in the background of several boxes in the design. 
The InDesign document has already been setup with four Object Styles that define the background color 
of the different schools.

Duration
About 15 minutes.

Objectives
After completing this module, you will be able to:

	z Create new Style content objects, and
	z Control both Character and Object styles.

Procedure
Checking the Object Styles

Step by step instructions

Open the Object Styles panel from the Window ->Styles menu, or hit Ctrl-F7. 

From the InDesign tool box, 
select the Selection tool 
(black pointer) .

Click the teal-colored box 
behind the textbox.

Notice that when you select the box, the General Object Style is highlighted to show that the 
box is using that style. 

You can manually click to change the object style to Engineering, Medicine or Law to see the 
color change to the school color. We want to do this automatically based  on a rule.

Additional information and notes

For this example, the styles have already been defined. However, in your future 
projects, you can also choose to setup new styles by selecting the Create New 
Style option in the rule editor which will open the standard InDesign style panel.
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Creating a new Style Content object (Object styles)

Step  by step instructions

In the Dynamic Content panel, right-click and 
select New Content Object... 

If the panel is not visible, open it from the 
Window menu, XMPie group. 

Enter a Name for the Content object, set the 
Type to Style and check the box to Edit Rule.

Change the Apply Style 
drop-down to If.

Select the School database 
field.

Select = and type in 
Engineering. 

Select to Apply the 
Engineering Object Style.

Change Else Apply Style to 
Else If.

Select the School database 
field.

Select = and type in Law. 

Select to Apply the Law 
Object Style.
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Change Else Apply Style to 
Else If.

Select the School database 
field.

Select = and type Medicine. 

Select to Apply the Medicine 
Object Style.

Next to Else Apply Style, select the General Object Style.

Our expression is complete. Click OK.

The new Content object is added to the bottom of the list in the Dynamic Content panel.

Place the new Style Content object into the design

Step  by step instructions

From the InDesign tool box, select the Selection tool (black pointer) .

Select the teal-colored box 
behind the text.

Double-click the School color 
Content object.

Scroll through your records to confirm that the box background color changes as expected.

Additional information and notes

The text comparison used in the above expression is case-sensitive. In this 
example, all the school database values are in title case. In your future work, 
you may have a situation where the database is not clean and may have 
different case for example: Engineering/engineering/ENGINEERING for different 
recipients. In this situation, you can use a formatting function to change the 
database value to always be uppercase or lowercase, and then enter the 
comparison string in that case.
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Select the teal-colored box 
behind the agenda text.

Double-click the School color 
Content object.

Scroll through your records to confirm that the box background color changes as expected.

Move to page 2 in the document.

Select the teal-colored box 
behind the letter text.

Double-click the School color 
Content object.

Scroll through your records to confirm that the box background color changes as expected.

Notice that for the School of 
Medicine, the white text on 
the pale blue background 
color is difficult to read. 
(Record 20 for example.)
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Creating a new Style Content object (Character styles)

Step  by step instructions

In the Dynamic Content panel, right-click and select New Content Object... 

Enter a Name for the Content object, set the 
Type to Style and check the box to Edit Rule.

Change the Apply Style 
drop-down to If.

Select the School database 
field.

Select = and type Medicine. 

Select to Apply the Blue 
Character Style.

Else, apply the White style.

Our expression is complete. Click OK.

The new Content object is added to the bottom of the list in the Dynamic Content panel.

Place the new Style Content object into the design

Step  by step instructions

From the InDesign tool box, select the Type tool  .

Select all the text in the letter 
text box.

Double-click the Text style 
Content object.

Scroll through the records to confirm that the text is dark blue when the Medicine School's 
pale blue background is displayed, and white for the other School colors.

Move back to page 1 of the document.
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Select all the text in the 
heading text box.

Double-click the Text style 
Content object.
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Module 4: 
Text File Content objects
Text File Content objects allow you to import text from a separate file into the InDesign document based 
on database logic. In this example, we have a folder of text file assets that represent the different open 
day agendas for each School. We will create a Text File content object to read in the different text files 
depending on the student's selected School.

Duration
About 10 minutes.

Objectives
After completing this module, you will be able to:

	z Create a new TextFile Content object, 
	z Set the Assets folder, and
	z Create a new InDesign table that is populated by the Table Content object.

Procedure
Check the available Text File assets

Step by step instructions

In the Tutorial files, open 
the folder of text files in the 
Assets folder.

Additional information and notes

These text files contain the agenda information for each School. We need to 
import the text file based on the database School field. 

There are two ways we can proceed:

1) We could rename the text files to be named just by the School - for example 
Law.txt, Medicine.txt, Engineering.txt and General.txt. And then our Rule would 
simply get the file with the same school name that is in the database. Or,

2) We could create a rule to select each file by its current name. For example: 
     If [T] School = "Engineering" Then "Open House engineering schedule.txt" 
     Else If...

The following steps will look at both options, although you will only need to 
create the Content object once using the option you prefer.
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Option 1 Rename the text file assets and create the Text File Content object

Step by step instructions

Rename the Text File Assets 
to include just the School 
name.

In the Dynamic Content panel, right-click on 
the School photo Content object.

Select Duplicate.

In the Dynamic Content panel, right-click on 
the new School photo copy Content object.

Select Rename.

Enter a better name for the new content object. 

Click Rename.

In the Dynamic Content panel, right-click on 
the School agenda Content object.

Select Type and then Text File.
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Option 2 Create the Text File Content object for the original text file asset names

Step by step instructions

In the Dynamic Content panel, right-click and 
select New Content Object....

Enter a Name for the Content object, set the 
Type to Text File and check the box to Edit 
Rule.

Change Text File = to If.

Select the School database 
field.

Select =.

Enter the text Engineering.

On the next row of the 
expression, select Browse... 
(at the very bottom of the 
drop-down list.)

NOTE: Special attention and warning

If you have created the School agenda content object using the previous step, please skip 
over this step. This is just to show how you could create a rule without having to rename the 
text file assets.
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Browse to the text file assets folder and select 
the Open House engineering schedule.txt file.

Click Open.

Change Else Text File = to 
Else if.

Select the School database 
field.

Select =.

Enter the text Law.

Next to Then Text File =, select Browse and select the Law open house schedule.txt file.

Change Else Text File = to 
Else if.

Select the School database 
field.

Select =.

Enter the text Medicine.

Next to Then Text File =, select Browse and select the medical - OpenHouse Schedule.txt 
file.

Next to Else Text File =, select Browse and select the general-schedule.txt.

Notice that the Preview area shows that a text file asset has been found.

Click OK.
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Place the new Text File Content object into the design

Step  by step instructions

From the InDesign tool box, select the Type tool  .

Click to place the cursor 
below the table, and hit the 
backspace/delete key to 
delete the static table.

Now, double-click the School 
agenda Text File Content 
object to place it into the 
design.

Scroll through some records to confirm that the text file is changing the table as expected.

NOTE: Special attention and warning

You will need to click below the blue guide line or your cursor will go into the 
table rather than below it.

Additional information and notes

If you have a keen eye, you will notice that the Medical School agenda also 
changes color. This is because the text files provided are Adobe InDesign Tagged 
Text. uCreate Print can work with plain text, rich text (RTF), Adobe InDesign 
Tagged Text or XMPie's XNIP text files. 

You can create Adobe InDesign Tagged Text Files by selecting text in InDesign, 
choosing export from the File Menu, and setting the Export Type to Adobe 
InDesign Tagged Text.

Additional information and notes

Text files are considered as assets, so you should include them in the assets 
folder, and use the Dynamic Content menu to set the assets location.

This step was not necessary in this tutorial because the document is already 
using graphic assets and the asset folder was defined in an earlier tutorial.
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Module 5: 
Dynamic Print
Our dynamic template is complete. We are ready to create the output file to print. Please note that 
Dynamic Print is only possible with a licensed version of uCreate Print.

Duration
About 10 minutes.

Objectives
After completing this module, you will be able to:

	z Create print output of one or more data source records, and
	z impose the output for optimized press sheet coverage.

Procedure
Variable data print

In this example we use default print settings to create page-by-page output for each record.

Step  by step instructions

From the Dynamic Content 
menu, select Generate VDP 
Output...

If you have not already saved 
the document, you will be 
prompted to do so.

Set the output Format to 
Adobe(r) PDF.

Set the range of Records that 
you would like to print. I will 
set 1 to 10.

Click OK.
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You will see a dialog indicating the print production progress.  After a few moments, the 
dialog will close and you are returned to the document.

In the folder where your InDesign document is saved, look for a new folder called output. 
Inside the output folder, uCreate Print will create a subfolder with the current date and time 
and save the output file into this folder.

Additional information and notes

For more information on other settings in the Dynamic Print dialog, refer to the 
uCreate Print User Guide by selecting Help from the Dynamic Content menu.

Additional information and notes

In addition to PDF, uCreate Print can output several other VDP output formats 
including PS, VIPP, VPS, PPML and PDF/VT-1. The best one to use will depend on 
your printer so you should do some tests to see which is smallest/fastest.

Additional information and notes

On the Dynamic print dialog, you can also choose to set the Destination. If you 
choose to set a destination, uCreate Print will save the output file in the folder of 
your choice. If you print multiple times with a custom destination, each print will 
overwrite any previous output file in that location.
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Variable data print with imposition

In this example we output the postcards imposed to a larger sheet size with bleed and trim marks.

Step  by step instructions

From the Dynamic Content 
menu, select Generate VDP 
Output...

If you have not already saved 
the document, you will be 
prompted to do so.

Set the output Format to 
Adobe PDF.

Set the range of Records that 
you would like to print. I will 
set From 1 and To 12.

Click OK.



30	 XMPie EDU Tutorial Part 4 - More Content object Types	 XMPie Training

Click Imposition.

Set Imposition Template to 
Step and Repeat.

Set Sheet Size to SRA3 
Landscape.

Set both Margin Width and 
Height to 0.08in (or 2mm)

Check Auto Calculate.

Check Duplex.

Check Centre Pages on 
Sheet.

Check Draw Cut Marks and 
enter 0.12in (or 3mm) for 
both x and y values.

Click OK.

When production finishes, check the output folder for a second subfolder, and open the 
output PDF to check your work.

Samples of the first two pages of the PDF output are shown on the next page.
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Review and extra exercises
To consolidate your understanding of the topics covered in this tutorial, please answer the following 
review questions, and complete the additional exercises:

Review questions
How do you remove a Visibility Content object from a layer? (Page 15)

  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

Do you need to prepare your Styles before creating the Style Content object? (Page 16)

  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

What type of text files are supported by Text File Content objects? (Page 26)

  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

Text files are assets and you should set the assets folder location to use them. True or false? (Page 26)  .  . 

Visibility Content objects can only turn on/off InDesign Layers. True or false? (Page 15)  .   .   .   .   .   .   .   .   .   .   .   

How can you create a text file that will include font style and color information? (Page 26)

  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

Should text file and graphic assets be named in a special way? (Page 22)

  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

Additional exercises
Exercise 1

In the previous tutorial we suggested that you take an existing InDesign document used in your company 
(for example a business card) and create a data source in Excel or CSV to contain all the data fields 
necessary for the document (firstname, lastname, address, phone, fax, email, etc). 

To continue the same theme, try these additional exercises:

1)	 Edit your document to include dynamic styles - for example, if the position or job title includes the 
word "Manager" then change the font style.

2) 	 Add a second page to your document (for example a colored back page for the business card) and 
use a Visibility Content object to turn on or off the second page based a database value - for example, 
you could use the city or state database field to turn on/off the page.
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